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1 Introduction 

1.1 Document Purpose 
This Configuration Guide provides and overview of VIPEDIA-12-PRO / INTEGRA-PRO units and describes 
the specific steps required to configure Dante audio routing in VIPEDIA-12-PRO and/or INTEGRA-PRO 
based systems. It also provides instructions on how to update the firmware on Dante modules. 

This guide does not provide: 

• Instructions on how to configure, set up and commission ASL devices in the PAVA system. 

• Details on non-Dante features on VIPEDIA-12-PRO / INTEGRA-PRO units. 

• Details on external network switches used in the system. 

Please see additional information in Sections “1.2 Prerequisites” (page 5) and “3 Configuration Overview” 
(page 11).  

1.2 Prerequisites 
This Configuration Guide assumes that: 

• The user is familiar with the configuration of VIPEDIA-12 and/or INTEGRA systems (non-Dante), 
including the use of the PAVA System Configuration Tool (PAVA SCT), VIPA Config Tool (VCT) and the 
setup of VIPEDIA-12, INTEGRA and VIPEDIA-NET devices. 

• The user is familiar with the use of the Dante Controller to configure Dante devices. 

• The configuration PC has the required tools: 

- PAVA System Configuration Tool (PAVA SCT) and VIPA Config Tool (VCT): available from ASL or 
an appointed ASL distributor. 

- Dante Controller: available from Audinate. 

• ASL devices in the PAVA system have the required firmware version. 

1.3 Software/Firmware Versions and This Configuration Guide 
The operation and features described here are correct for: 

• VIPEDIA-12-PRO / INTEGRA-PRO / VIPEDIA-12 / INTEGRA V4.2.0.6P 

• PAVA System Configuration Tool (PAVA SCT) V4.2.0.5P 

• Dante Brooklyn II firmware version V4.1.1.4 

• Dante Controller V4.4.2.2 

If the VIPEDIA-12-PRO / INTEGRA-PRO, PAVA SCT or Dante module in your system has a later (or earlier) 
version of software, then it may mean that some aspects of the operation and configuration are subtly 
different from the operation described in this document, or that enhanced features have been added.  

If any difficulties are encountered, contact ASL or an appointed ASL distributor, quoting the: 

• Serial number of your VIPEDIA-12-PRO / INTEGRA-PRO unit 

See location and example of serial number label in “APPENDIX C –  Serial Number Label” (page 100). 

• VIPEDIA-12-PRO / INTEGRA-PRO software version 

The version number is available from the unit’s front panel menu option: 

Configuration > Router > Identity > S/Ware > Host CP 
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• Dante Brooklyn II firmware version 

See “APPENDIX B – Getting the firmware version on a Dante Brooklyn II module” (page 99). 

• PAVA System Configuration Tool (PAVA SCT) version 

The version number is available in the title of the main window. 

• Dante Controller version 

The version number is available in Help > About window. 

1.4 Conventions Used in This Document 

ADT: refers to the Amplifier Dynamic Configuration Tool 

FTT: refers to the File Transfer Tool 

PAVA SCT: refers to the PAVA System Configuration Tool 

PRO: refers to VIPEDIA-12-PRO and  INTEGRA-PRO units 

RDT: refers to the Router Dynamic Configuration Tool 

VCT: refers to the VIPA Config Tool 

Vipedia refers to VIPEDIA-12, INTEGRA, VIPEDIA-12-PRO and/or  INTEGRA-PRO 
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2 VIPEDIA-12-PRO / INTEGRA-PRO Overview 

2.1 Non-Dante Features 
VIPEDIA-12-PRO / INTEGRA-PRO units provide the same functionalities as VIPEDIA-12 / INTEGRA units. 
However, note that PRO units cannot be used in DBB groups (i.e. VIPEDIA-24, VIPEDIA-36, VIPEDIA-48 
and VIPEDIA-12-AB configurations) and do not support Active Standby (AS) redundancy. 

For details of non-Dante features, please refer to: 

• PAVA SCT User’s Manual (Table 2:[1] on page 94): Configuration of VIPEDIA-12 / INTEGRA units, 
VIPEDIA-NET devices, amplifier mainframes and peripherals. 

• INTEGRA User’s Manual (Table 2:[3] on page 94): Configuration of INTEGRA units. 

2.2 Dante Features 
A VIPEDIA-12-PRO / INTEGRA-PRO unit is a VIPEDIA-12 / INTEGRA unit fitted with a VIPEDIA-NET 
Network Card with integrated Dante Brooklyn II module1.  

In a system with VIPEDIA-12-PRO / INTEGRA-PRO units, 32 sources can be routed between devices using 
Dante. Currently, only analogue audio input (including microphones) can be routed using Dante.  

Emergency microphones routed using Dante can be used in EN 54-16 systems.  

DVA messages are always routed to remote units using ASL’s Portable Media Carrier (PMC) format.  

ASL’s PMC is also used for routing audio sources between VIPEDIA-12-PRO / INTEGRA-PRO and 
VIPEDIA-12 / INTEGRA units. 

All VIPEDIA-12-PRO / INTEGRA-PRO units in the system should be equally configured to subscribe to all 
Dante sources. This ensures that audio is always routed over IP using the correct transport method (Dante 
or PMC).  

2.3 Dante Outputs 
All audio inputs and outputs of a VIPEDIA-12-PRO / INTEGRA-PRO unit are always available on the Dante 
network with no configuration required.  

Any of the Dante outputs (transmitter channels) can easily be routed to Dante enabled devices (e.g. 
amplifiers) using the Dante Controller.  

Table 1 (page 8) contains the allocation of Dante transmitter channels to VIPEDIA-12-PRO / INTEGRA-PRO 
audio inputs and outputs.  

 

 

 

 

 

 

 

 
1  The VIPEDIA-NET Network Card with integrated Dante Brooklyn II module is factory fit only. 
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Table 1 VIPEDIA-12-PRO / INTEGRA-PRO Dante transmitter channel allocation  

Dante Transmitter Channel (Tx) VIPEDIA-12-PRO / INTEGRA-PRO Notes 

1 Input 1 

1) Input tapping point:  
AFTER channel processing  
(Trim > EQ > Gate > 
Compressor > Limiter > Fader > 
Chime Generator > Mute). 

2 Input 2 

3 Input 3 

4 Input 4 

5 Input 5 

6 Input 6 

7 Input 7 

8 Input 8 

9 Input 9 

10 Input 10 

11 Input 11 

12 Input 12 

13 Output 1 

2) Output tapping point:  
AFTER output processing (EQ > 
Delay > Fader > Mute > Limiter) 
but PRE addition of surveillance 
tones. 

3) Tx Channels 17 to 24 (Outputs 5 to 
12) should not be used as there 
may be overlap with other audio 
sources.  

14 Output 2 

15 Output 3 

16 Output 4 

17 Output 5 (do not use) 

18 Output 6 (do not use) 

19 Output 7 (do not use) 

20 Output 8 (do not use) 

21 Output 9 (do not use) 

22 Output 10 (do not use) 

23 Output 11 (do not use) 

24 Output 12 (do not use) 

25 Reserved 

4) Tx Channels 25 to 32 appear in 
the Dante Controller but are 
RESERVED. 

26 Reserved 

27 Reserved 

28 Reserved 

29 Reserved 

30 Reserved 

31 Reserved 

32 Reserved 
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2.4 Third-Party Dante Sources 
Third-party Dante sources can be routed unprocessed or processed: 

• Unprocessed:  

- No dynamic processing (EQ, gate, compressor and limiter) or gain adjustment is applied to the 
Dante source. 

- If required, processing must be applied at the output stage of the third-party transmitting device. 

- Can only be routed using Dante to outputs on VIPEDIA-12-PRO / INTEGRA-PRO units. 

- Configuration details in Section “4.5 Third-Party Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO 
(Unprocessed)” (page 40). 

• Processed:  

- An audio input is used for each third-party Dante source. 

- Input dynamic processing (EQ, gate, compressor and limiter) and gain adjustment can be applied to 
the processed Dante input using the Router Dynamic Configuration Tool (RDT). 

- Can be routed using PMC to remote units. 

- Can also be routed using Dante to outputs on VIPEDIA-12-PRO / INTEGRA-PRO units. 

- Can be used as VOX gate route trigger.  

- Configuration details in Section “4.6 Third-Party Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO 
VIPEDIA-12 / INTEGRA (Processed)” (page 58). 

Third-party Dante sources (unprocessed or processed) can be routed using contacts, microphone buttons, 
permanent routes, VOX routes, and as VIPA BGM; see Section “4.7 Configuration of Dante Audio in PAVA 
Routes” (page 80) for further details. 

2.5 Dante and ASL PAVA Networks 
ASL’s PAVA devices operate in 100 Mbit/s Ethernet, whereas Dante devices operate in 100 Mbit/s and 
Gigabit Ethernet.  

This section provides an overview of the Dante and ASL PAVA network. If required, please refer to ASL for 
further information on requirements for Dante and ASL PAVA networks. 

2.5.1 IP Address Ranges 

Dante and VIPEDIA-12 / INTEGRA operate on separate IP networks: 

• Dante devices operate using link-local addressing, with devices automatically assigned an address in the 
169.254.0.0/16 range.  

• VIPEDIA-12 / INTEGRA units and other ASL devices operate using statically assigned IP address (by 
default, in the 192.168.1.0/24 range). 

It is, therefore, recommended to connect to the Dante device network through a dedicated network interface, 
which must be set to ‘obtain an IP address automatically’.  

“APPENDIX A – PC Requirements for ASL Configuration Tools and Dante Controller” (page 95) provides 
details of the required settings. 
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2.5.2 Group Management Protocol (IGMP) 

As standard, the Brooklyn II module on VIPEDIA-12-PRO / INTEGRA-PRO units are configured to transmit 
audio using multicast flows. Each unit will be configured with up to two multicast flows, each multicast flow 
with up to eight channels. Unlike unicast routing, multicast flows consume network bandwidth even if there 
are no receivers, but do not require additional bandwidth to add more receivers. To manage the multicast 
traffic on the network traffic, IGMP-enabled network switches may be required.  

2.5.3 Loop Networks 

VIPEDIA-12-PRO / INTEGRA-PRO only supports a single network connection. It cannot, therefore, support 
loop network topology which is normally required for Voice Alarm applications. 

External switches that support Rapid Spanning Tree Protocol (RSTP) should be used where VIPEDIA-12-
PRO / INTEGRA-PRO units are required to be connected in a loop network.  

For networks using Hirschmann or ASL network switches, refer to: 

• Hirschmann Network Switch RS20/30/40 Configuration Guide (Table 2:[5] on page 94) 

• NETWORK-SWITCH-LP01 Configuration Guide (Table 2:[6] on page 94) 

2.5.4 Isolated Dante Network 

For flexibility and network performance, VIPEDIA-12-PRO / INTEGRA-PRO V4.1.x.x (or newer) allows Dante 
traffic to be routed in the same network as the ASL’s PAVA traffic or in a separate 1G network. Refer to 
Section “4.2 Adding VIPEDIA-12-PRO / INTEGRA-PRO to the PAVA System Configuration” (page 15) for 
configuration details.  

2.6 Limitations 
• Maximum of 32 Dante channels per system. 

• Dante sample rate must be 48 kHz. 

• Dante outputs for outputs 5 to 12 (Tx Channels 17 to 24) should not be used by third-party Dante 
devices as there may be used for internal routing.  

• VIPEDIA-12-PRO units cannot be used in DBB groups (i.e. VIPEDIA-24, VIPEDIA-36, VIPEDIA-48 and 
VIPEDIA-12-AB configurations). 

• VIPEDIA-12-PRO units do not support Active Standby (AS) redundancy. 

• External switches that support Rapid Spanning Tree Protocol (RSTP) should be used in loop network 
applications. 

• IP microphones cannot be routed using Dante. 

• DVA messages are always transmitted using PMC. 

• Limited route validation in the PAVA SCT: allows unprocessed third-party Dante sources to be routed to 
non-Dante units.  

• Not possible to import Dante Controller configuration files into the PAVA SCT. 

• Third-party device configuration is not included in the Dante Controller configuration generated by the 
PAVA SCT.  

• Generated Dante XML configurations might not match other tools. 

• Configuration PC needs two network interfaces: one with fixed IP address (for the PAVA network) and 
the other with dynamic IP address (for the Dante network).  
A single network interface can be used for both networks, but it must be reconfigured for each network. 
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3 Configuration Overview 

The basic configuration process is outlined in the diagram in Figure 1 (page 12).  

Important:  

It is assumed that: 

• The user is already familiar with configuration and setup of non-Dante based VIPEDIA-12 / INTEGRA 
systems. If required, reference material is listed in the diagram in Figure 1 (page 12).  

• The Dante Brooklyn II module is configured using the Dante configuration generated by the PAVA SCT. 
You can always manually configure the Dante devices using the Dante Controller as long as the Dante 
channel subscriptions on Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO match 
the configuration shown on the Dante page of the PAVA SCT; see examples in Figure 3 (page 31), 
Figure 4 (page 44) and Figure 5 (page 62). 

• The configuration PC has the required tools: 

- PAVA System Configuration Tool (PAVA SCT) and VIPA Config Tool (VCT): available from ASL or 
an appointed ASL distributor. 

- Dante Controller: available from Audinate. 

• The configuration PC’s network interface(s) used to connect to ASL’s PAVA devices and/or Dante 
devices is(are) correctly configured; see “APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller” (page 95) for further details. 
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Figure 1 VIPEDIA-12-PRO / INTEGRA-PRO and Dante Audio Routing Configuration process 

  Refer to 

 (1) Create the system configuration using the PAVA System Configuration Tool (PAVA SCT).  

 a) VIPEDIA-12 / INTEGRA units including the Network Card (if any) [1] 

 b) VIPEDIA-12-PRO / INTEGRA-PRO units including the Network Card and Amplifier Frame [1] [2] 

 c) V2000 Amplifier Frames [1] [4] 

 d) Miscellaneous inputs and peripherals (such as microphones, BMB01 Remote I/O Units and WMC01 
Wall-Mount Controllers) [1] 

 e) Dante routing on VIPEDIA-12-PRO / INTEGRA-PRO units [2] 

 f) Third-party Dante devices (if any) [2] 

 g) Routes (contact inputs, microphone buttons, permanent routes, VOX routes and/or BGM streams) [1] [2] 

 

 

 

 (2) If any, set-up and configure the network switches. [5] [6] 

 

  

 

 (3) Set-up the unit ID and IP addresses of ASL’s PAVA devices using the system configuration. [1] 

 

 

 

 (4) Load the system configuration into ASL’s PAVA devices using the File Transfer Tool (FTT).  [1] 

 

 

 

 (5) Configure Dante devices by loading the Dante Controller XML configuration using the Dante Controller. [2] 

 

 

 

 (6) Commission the V2000 and INTEGRA Amplifier Frames using the Amplifier Dynamic Configuration Tool 
(ADT) as required. 

[4] 

 

 

 

 (7) Test audio is correctly routed and commission the dynamics settings using the Router Dynamic 
Configuration Tool (RDT) as required. 

[2] [3]  

   

Reference documentation/section: 
[1] PAVA SCT User’s Manual (Table 2:[1] on page 94) and/or INTEGRA User’s Manual (Table 2:[3] on page 94) for configuration 

tasks not specific to VIPEDIA-12-PRO / INTEGRA-PRO and Dante 
[2] Section “4 Configuration Tasks Specific to VIPEDIA-12-PRO / INTEGRA-PRO and Dante” (page 13) 
[3] VIPEDIA-12 User’s Manual (Table 2:[2] on page 94) 
[4] V2000 User’s Manual (Table 2:[4] on page 94): for configuration and commissioning V2000 and INTEGRA amplifier frames 
[5] Hirschmann Network Switch RS20/30/40 Configuration Guide (Table 2:[5] on page 94) 
[6] NETWORK-SWITCH-LP01 Configuration Guide (Table 2:[6] on page 94) 
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4 Configuration Tasks Specific to VIPEDIA-12-PRO / 
INTEGRA-PRO and Dante 

4.1 Getting the MAC Address of a Dante Brooklyn II Module 
Important: 
a) Dante MAC addresses will always be of the format: 00:1D:C1:xx:xx:xx 

b) The Dante MAC address is not essential but will simplify the Dante Brooklyn II module configuration. 

4.1.1 DANTE MAC Address Label on VIPEDIA-12-PRO 

 

4.1.2 DANTE MAC Address Label on INTEGRA-PRO 

 

Rear panel (left side) 

(A QR code scanner can be used to load the MAC address directly into the PAVA SCT.) 

Top of Router (left side) 

(A QR code scanner can be used to load the MAC address directly into the PAVA SCT.) 
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4.1.3 MAC Address on the Dante Controller 

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools and 
Dante Controller” (page 95) for further details.  

 

1. Launch the Dante Controller.  

2. Select the Routing tab in Dante Controller - Network View main window. 

3. Double-click the required device name in matrix to open the Device View window. 

4. Select the Status tab. 

The firmware versions are shown in the Dante Information box. 

The MAC address is shown in the Interfaces box. 

Note: 
The default name contains the MAC address and is of the format BKLYN-II-xxxxxx, where xxxxxx are 
the last three blocks of the MAC address 00:1D:C1:xx:xx:xx. 

 

The default name contains the MAC address: 
 

BKLYN-II-xxxxxx 
 

00:1D:C1:xx:xx:xx 
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4.2 Adding VIPEDIA-12-PRO / INTEGRA-PRO to the PAVA System 
Configuration 

Important: 
a) The following procedure describes the configuration of features applicable to VIPEDIA-12-

PRO / INTEGRA-PRO units only.  

b) For general configuration, refer to the PAVA SCT User’s Manual (Table 2:[1] on page 94) and/or 
INTEGRA User’s Manual (Table 2:[3] on page 94).  

 

1. On the PAVA SCT device tree, right-click the PA/VA Cluster node. 

2. Select Add > Ins, and then the required PRO node type: VIPEDIA-12-PRO or INTEGRA-PRO. 

3. Expand the node and select the required VIPEDIA-12-PRO or INTEGRA-PRO unit. 

4. Enter the unit’s Name.  

The Name will also be assigned to the unit’s Dante Brooklyn II module. 

5. Enter the Dante Module MAC Address; see Section “4.1 Getting the MAC Address of a Dante 
Brooklyn II Module” (page 13). 

The Dante MAC address is not essential but will simplify the Dante Brooklyn II module configuration.  

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 16 of 100 

6. Select the PA/VA Cluster node to load the PA/VA Cluster Options configuration pane and select 
whether the Dante traffic is to be isolated from the ASL’s PAVA traffic in a separate 1G network. 

This feature is available on VIPEDIA-12-PRO / INTEGRA-PRO V4.1.x.x (or newer). 

 

7. Configure the VIPEDIA-12-PRO / INTEGRA-PRO unit and peripherals (Amplifier Frames, 
microphones, GPIO contacts, etc.). 

8. At this stage, although the configuration is valid, audio would still be routed between devices using 
ASL’s PMC technology, not using Dante (where applicable). 

Follow the configuration sections below for audio routing by Dante as required: 

• “4.3 VIPEDIA-12-PRO / INTEGRA-PRO to Third-Party Dante Devices” (page 17) 

• “4.4 VIPEDIA-12-PRO / INTEGRA-PRO to VIPEDIA-12-PRO / INTEGRA-PRO” (page 28) 

• “4.5 Third-Party Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO (Unprocessed)” (page 40) 

• “4.6 Third-Party Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO VIPEDIA-12 / INTEGRA 
(Processed)” (page 58) 

• “4.7 Configuration of Dante Audio in PAVA Routes” (page 80) 

 

 

 

 

 

 

 

 

If isolated, the SFP ports ETH5 
and ETH6 are disconnected from 
the internal switch and exclusively 
used by the Dante module.  
And copper ports ETH1, ETH2, 
ETH3 and ETH4 are used by the 
PAVA network (i.e., Vipedias and 
Network Cards) as standard. 
Dante network (ETH5 and ETH6) 
should not be isolated from the 
PAVA network where Dante is 
used for VA applications. 
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4.3 VIPEDIA-12-PRO / INTEGRA-PRO to Third-Party Dante Devices 
This section describes the configuration of third-party Dante devices to listen to inputs and outputs of 
VIPEDIA-12-PRO / INTEGRA-PRO units. 

 

Important: 
a) Table 1 (page 8) contains the allocation of Dante transmitter channels to VIPEDIA-12-PRO / INTEGRA-

PRO audio inputs and outputs. 

b) Dante transmit channels Tx17 to 24 on VIPEDIA-12-PRO / INTEGRA-PRO (outputs 5 to 12) should not 
be used by third-party Dante devices as there may be overlap with other audio sources. 

4.3.1 PAVA SCT Configuration (PRO to Third-Party) 

All audio inputs and outputs of a VIPEDIA-12-PRO / INTEGRA-PRO unit are always available on the Dante 
Network. No configuration is required in the PAVA SCT. 

Any of the Dante outputs (transmitter channels) can easily be routed to Dante enabled devices (e.g. Dante 
amplifiers) using the Dante Controller as described below.  

4.3.2 Dante Brooklyn II Module Configuration (PRO to Third-Party) 

Important: 
a) Although the Dante configuration file generated by the PAVA SCT does not contain the configuration of 

the third-party Dante devices, it is recommended that the configuration is loaded into all Brooklyn II 
modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO units in the system. This will simplify the 
configuration of third-party devices. Also, any subscriptions between VIPEDIA-12-PRO / INTEGRA-PRO 
units will also be automatically configured in the same process. 

b) The Dante page on the PAVA SCT shows the allocation of Dante transmitter channels to VIPEDIA-12-
PRO / INTEGRA-PRO audio inputs and outputs; see example in Figure 2 (page 18). 

 

VIPEDIA-12-PRO / 
INTEGRA-PRO

Third-Party Device
(e.g Mixer)
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1. On the PAVA SCT, select the Dante page and check Tx channel allocation for the required audio 
inputs and/or outputs. 

Figure 2 Dante page: Tx channels for (audio inputs and outputs 

 

2. If all you want to do is use Dante to listen to ASL’s Dante devices, then you can skip the configuration 
using the Dante Controller XML generated by the PAVA SCT, and go to step 10 (page 23).  

Note that the Dante Controller XML configuration generated by the PAVA SCT can be installed to set 
the device and channel labels as seen on the PAVA SCT. 

3. On the PAVA SCT, export the Dante Controller XML configuration using the menu option: 

File > Export Dante Controller File 

 

Outputs 01 to 04: Tx13 to Tx16  
Outputs 05 to 12: not available as 
there may be overlap with other 
audio sources 

Inputs 01 to 12: Tx01 to Tx12 
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Alternatively, right-click the Dante item in the device tree and select Export Dante Controller File 
option from the context menu. 

 

Or click the Export Dante Controller File button on the Dante page. 
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4. Launch the Dante Controller.  

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller” (page 95) for further details. 

5. Select the Routing tab in Dante Controller - Network View main window and ensure that all required 
devices are present on the network. 

6. Load the Dante XML configuration using the menu option: 

File > Load Preset 
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7. The Preset Elements list shows the elements that can be imported from the configuration.  

It is recommended to select all available elements. 

a. If the MAC addresses are present in the configuration, it should automatically identify and apply 
the role to the correct device.  

 

b. If the MAC addresses are not present in the configuration, assign the roles to the Dante devices 
on the network.  

i. The Preset Roles list shows the devices in the configuration and the Target Devices list 
shows the devices found on the network. 

ii. Select a device in the Preset Roles list and its equivalent device the Target Devices list, 
and then click the Apply Role button. 

Alternatively, select a device in the Preset Roles list, and drag and drop it on top of its 
equivalent device in the Target Devices list. 

iii. Repeat the above steps for all devices in the Preset Roles list.  

Important: 
To simplify identifying the correct device on the network amongst various devices with default 
name, it is recommended that each Dante module is configured whilst it is the only device with 
default name on the network. 
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8. Click the Ok button to apply the configuration.  

It may take a while depending on the number of devices. 

9. Once completed, click the Ok button. 

Device and channel names will have been updated and routes between Dante Brooklyn II modules 
fitted VIPEDIA-12-PRO / INTEGRA-PRO units will be made (if any). 

 

10. On the Routing tab, ensure that all required devices are present on the network. 

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 24 of 100 

11. Expand the required transmitter device (VIPEDIA-12-PRO / INTEGRA-PRO) along the top.  
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12. Expand the required receiver device (third-party) along the left side.  
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13. Position the mouse on the intersection of the correct receive (Rx) and transmit (Tx) channels.  

In the example below, Rx10 of Mixer-01 is to be connected to Tx13 (output 1 of Vipedia VIP03). 

Note: 

All audio inputs and outputs of a VIPEDIA-12-PRO / INTEGRA-PRO unit are always available on the 
Dante Network in pre-defined transmit channels:  

• Input 1 on Tx01, input 2 on Tx02, …, and input 12 on Tx12  

• Output 1 on Tx13, output 2 on Tx14, and output 12 on Tx24 

Tx17 to Tx24 (outputs 5 to 12) should not be used as there may be overlap with other audio 
sources. 

See Table 1 (page 8) for further details on Dante transmit channel usage on VIPEDIA-12-PRO / 
INTEGRA-PRO units.  
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14. Click on the intersection to create a subscription between the receive and transmit channels. 

15. A green tick will appear in the intersection. You may initially see a grey hourglass icon (usually very 
briefly) to indicate that the subscription is in progress. 

In the example below, third-party device Mixer-01:Rx10 is connected to Vipedia VIP03:Tx13. 

Important: 
Subscriptions between third-party devices and Brooklyn II modules on VIPEDIA-12-PRO / INTEGRA-
PRO units may be erased when the PAVA SCT configuration is updated and reapplied using the 
Dante Controller. 

 

16. Repeat steps 11 to 14 for other third-party devices (if any). 
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4.4 VIPEDIA-12-PRO / INTEGRA-PRO to VIPEDIA-12-PRO / 
INTEGRA-PRO 

This section describes the configuration of audio inputs of VIPEDIA-12-PRO / INTEGRA-PRO units routed 
over Dante, where the input source can be miscellaneous audio (e.g. BGM) or microphone audio.  

 

4.4.1 PAVA SCT Configuration (PRO to PRO) 

1. On the PAVA SCT, select the required VIPEDIA-12-PRO or INTEGRA-PRO node. 

2. Expand the node down to Audio Inputs. 

3. Right-click the required Audio Input, and then select Add > Ins >Misc. Input to add a miscellaneous 
input or Add > Ins > <serial microphone>. 

The examples in this section show a Miscellaneous Input.  

 

VIPEDIA-12-PRO / 
INTEGRA-PRO

VIPEDIA-12-PRO / 
INTEGRA-PRO
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4. On the Audio Input configuration page, tick Route over Dante for ASL PRO devices. 

The PAVA SCT automatically allocates a Dante receive channel (Rx) to the Dante transmit channel 
(Tx) associated with this audio input. 

This tells all VIPEDIA-12-PRO and INTEGRA-PRO units in the system to listen to the this Dante 
transmit channel when this input is routed.  

Notes: 

a) Up to 32 Dante receive channels are available system wide.  

b) The PAVA SCT automatically assigns the lowest available receive channel (Rx). 

c) All audio inputs of a VIPEDIA-12-PRO / INTEGRA-PRO unit are always available on the Dante 
Network in pre-defined transmit channels: input 1 on Tx01, input 2 on Tx02, …, and input 12 on 
Tx12.  

See Table 1 (page 8) for further details on transmit channel usage.  

d) The Dante page shows the Dante channel allocation for each VIPEDIA-12-PRO / INTEGRA-PRO 
unit and third-party Dante device in the system; see an example in Figure 3 (page 31). 

e) If Route over Dante for ASL PRO devices is not selected, the input will be routed using PMC as 
normal.  

In the example below, input 5 of Vipedia VIP03 is configured to route over Dante using Rx01.  

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 30 of 100 

5. Select the input and enter a meaningful Name. 
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6. The Dante page shows the Dante channel allocation for each VIPEDIA-12-PRO / INTEGRA-PRO unit 
and third-party Dante device in the system. 

The Dante page for the transmitter unit will show a tick in the intersection of the transmit channel (Tx) 
used by the audio input and the configured receive channel (Rx). For receiver units (remote units), it 
will show the receive channel (Rx) assigned to the audio input.  

In the example below, the Dante page for Vipedia VIP03 (transmitter) shows a tick in the intersection 
of receive channel Rx01 and transmit channel Tx05 (which is always used by audio input 5). For 
receiver units, the Dante page shows receive channel Rx01 assigned to input 5 of Vipedia VIP03.  

Figure 3 Dante page example (audio input over Dante) 

 

Transmitter (VIP03) 

Receiver (VIP04) 

 

Tab Label - Icon Description 

Arrow  No audio input configured as serial microphone, miscellaneous input, or Dante feed. 

Star 
 

No audio inputs routed over Dante, i.e., no Rx channel assigned to an audio input.  

Single tick  
One or more audio inputs routed over Dante, i.e., an Rx channel is assigned to one or more audio 
inputs. 

Double tick 
 

All configured audio inputs are routed over Dante. i.e., an Rx channel is assigned to all serial 
microphones, miscellaneous inputs and/or Dante feeds. 

Note: 
Dante feed is a third-party Dante source that is processed using an audio input. 
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7. Repeat the above steps for all required audio inputs.  

8. Configure routes as normal: contact inputs, microphone buttons, permanent routes, program/source 
selectors, wall-mount controllers, VOX routes (as source), and/or as BGM streams.  

If a Miscellaneous Input is routed over Dante, the input will be identified as [DANTE] in the Source list 
of routing configuration dialogs; see example below for contact input routing. 

Refer to the following sections for further details: 

• “4.7.1 Dante Audio as Source in Contact / Microphone Button / Permanent / Source Selector / 
Wall-Mount Controller / VOX Routes” (page 80) 

• “4.7.2 DANTE Audio as VIPA BGM Sources” (page 82)  

• “4.7.3 Processed Third-Party Dante Source as VOX Route Trigger” (page 83) 

Notes: 
a) The Transport column in routing configuration dialogs identifies the transport methods for voice 

over IP that the receiver can handle (PMC and/or Dante), not necessarily the transport method 
that will used when the route is made. The audio source type will determine the transport method 
that will be used when the route is made. 

b) Although routes are allowed in the configuration, unprocessed third-party Dante sources will not 
be routed over PMC to standard VIPEDIA-12 / INTEGRA units. Unprocessed third-party Dante 
sources can be routed to VIPEDIA-12-PRO / INTEGRA-PRO units only (over Dante). 

c) Although the system configuration is correct, Dante routes will not route audio until the Dante 
Brooklyn II modules are correctly configured using the Dante Controller; see Section “4.4.2 Dante 
Brooklyn II Module Configuration (PRO to PRO)” (page 33). 

 

[DANTE] Sources: 
• Sources from a PAVA Router (VIPxx or ITGxx) will be 

routed over Dante to VIPEDIA-12-PRO and 
INTEGRA-PRO units, and over PMC to standard 
VIPEDIA-12 / INTEGRA units. 

• Sources from third-party devices (DNTxx) are 
unprocessed and will be routed over Dante to 
VIPEDIA-12-PRO and INTEGRA-PRO units. Although 
allowed in the configuration, they will not be routed to 
VIPEDIA-12 / INTEGRA units. 

Transport methods for voice over IP that the 
receiver can handle, not necessarily the method 
used when the route is made. 
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9. Load the configuration to the ASL’s 
PAVA devices using the File Transfer 
Tool (FTT). 

 

4.4.2 Dante Brooklyn II Module Configuration (PRO to PRO) 

1. On the PAVA SCT, export the Dante Controller XML configuration using the menu option: 

File > Export Dante Controller File 
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Alternatively, right-click the Dante item in the device tree and select Export Dante Controller File 
option from the context menu. 

 

Or click the Export Dante Controller File button on the Dante page. 
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2. Launch the Dante Controller.  

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller” (page 95) for further details. 

3. Select the Routing tab in Dante Controller - Network View main window and ensure that all required 
devices are present on the network. 

4. Load the Dante XML configuration using the menu option: 

File > Load Preset 
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5. The Preset Elements list shows the elements that can be imported from the configuration.  

It is recommended to select all available elements. 

a. If the MAC addresses are present in the configuration, it should automatically identify and apply 
the role to the correct device.  

 

b. If the MAC addresses are not present in the configuration, assign the roles to the Dante devices 
on the network.  

i. The Preset Roles list shows the devices in the configuration and the Target Devices list 
shows the devices found on the network. 

ii. Select a device in the Preset Roles list and its equivalent device the Target Devices list, 
and then click the Apply Role button. 

Alternatively, select a device in the Preset Roles list, and drag and drop it on top of its 
equivalent device in the Target Devices list. 

iii. Repeat the above steps for all devices in the Preset Roles list.  

Important: 
To simplify identifying the correct device on the network amongst various devices with default 
name, it is recommended that each Dante module is configured whilst it is the only device with 
default name on the network. 
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6. Click the Ok button to apply the configuration.  

It may take a while depending on the number of devices. 

7. Once completed, click the Ok button. 

Device and channel names will have been updated and routes between Dante Brooklyn II modules 
fitted VIPEDIA-12-PRO / INTEGRA-PRO units will be made (if any). 

 

8. On the Routing tab, ensure that all required devices are present on the network. 
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9. Routes can be confirmed by the green ticks inside the matrix. 

a. Along the top, expand the transmitter device. 

b. Along the left side, expand each receiver device fitted to VIPEDIA-12-PRO / INTEGRA-PRO units. 

A green tick in the intersection of the configured Rx and Tx channels indicate that the subscription 
is OK and audio should be flowing.  

In the example PAVA SCT configuration on page 29, Input 5 of Vipedia 03 is configured to route 
over Dante using Rx01. All Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO 
units show a green tick in the intersection of Rx01 and Vipedia 03:Tx05. 

Notes: 
a) The Rx channels of all Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO 

units in the system configuration should subscribe to the same Tx channels across the system. 
This ensures that audio is always routed over IP using the correct transport method.  

b) The Dante channel subscriptions on Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / 
INTEGRA-PRO should match the configuration shown on the Dante page of the PAVA SCT; see 
example in Figure 3 (page 31). 
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4.5 Third-Party Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO 
(Unprocessed) 

This section describes the configuration of unprocessed third-party Dante sources that can be routed to 
VIPEDIA-12-PRO / INTEGRA-PRO units.  

Important: 
a) Unprocessed third-party Dante sources can only be routed using Dante to outputs on VIPEDIA-12-PRO / 

INTEGRA-PRO units. 

b) If routing to standard VIPEDIA-12 / INTEGRA units is required, the third-party Dante source must be 
processed by a VIPEDIA-12-PRO / INTEGRA-PRO unit first as described in Section “4.6 Third-Party 
Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO VIPEDIA-12 / INTEGRA (Processed)” (page 58). 

c) No dynamic processing (EQ, gate, compressor and limiter) or gain adjustment is applied to the Dante 
source. 

d) If required, processing must be applied at the output stage of the third-party transmitting device. 

 

 

4.5.1 PAVA SCT Configuration (Third-Party to PRO - Unprocessed) 

1. On the PAVA SCT device tree, right-click the Dante item. 

2. Select Add > Ins, and then External Dante Device. 

The PAVA SCT automatically assigns the lowest available Unit ID (1 to 63 range). 

 

Third-Party Device
(e.g Mixer)

VIPEDIA-12-PRO / 
INTEGRA-PRO
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3. Select the required Dante Device in the device tree to load the configuration page. 

4. Enter the device’s Name.  

5. Enter the Dante Module MAC Address; see Section “4.1.3 MAC Address on the Dante Controller” 
(page 14) 

The Dante MAC address of a third-party device is not essential. It is not currently used but may be 
useful in the future. 

6. Select the number of Dante transmit channels from the Number of Dante Feeds drop-down menu (8, 
16, 32 or 64).  
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7. Enter a name for each Dante stream (SRCxx) available from the device, where SRCxx equates to 
Transmit Channel xx on the third-party device 

Notes: 
a) Using names that are assigned to the transmit channel on the Dante Controller helps the 

configuration.  

b) The source name must be filled in for Rx channel and route configuration. 
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8. Select the Dante streams that will be routed to VIPEDIA-12-PRO / INTEGRA-PRO units by ticking the 
Rx check box of the required stream (SRCxx). 

The PAVA SCT automatically allocates a Dante receive channel (Rx) to the third-party Dante stream 
(SRCxx). 

This tells all VIPEDIA-12-PRO and INTEGRA-PRO units in the system to listen to the this Dante 
stream when this source is routed. 

Important: 
a) Only select an Rx channel for Dante streams that are routed to VIPEDIA-12-PRO / INTEGRA-

PRO outputs (and inputs, if processed).  

b) Selecting an Rx channel for streams that are not routed within the PAVA system will reduce the 
number of Dante channels available for the PAVA system.  

In the example below, 6 x Dante streams are selected on third-party device DNT06: SRC01<>Rx06, 
SRC02<>Rx07, SRC11<>Rx08, SRC12<>Rx09, and SRC18<>Rx10. 
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9. The Dante page shows the Dante channel allocation for each PRO and third-party Dante unit in the 
system. 

The Dante page for the transmitter unit (the third-party device) will show a tick in the intersection of 
the transmit channel (Tx) and the configured receive channel (Rx). For receiver units (VIPEDIA-12-
PRO and INTEGRA-PRO units), it will show receive channels (Rx) assigned to the third-party Dante 
streams.  

In the example below, the Dante page for Vipedia VIP03 (and all other VIPEDIA-12-PRO and 
INTEGRA-PRO units) shows receive channel Rx06 assigned to SCR01; Rx07 to SCR02, Rx08 to 
SRC11, Rx09 to SCR12, and Rx10 to SCR18 of third-party device DNT06. 

Figure 4 Dante page example (third-party Dante sources) 

 

 

Tab Label - Icon Description 

Arrow  No audio input configured as serial microphone, miscellaneous input, or Dante feed. 

Star 
 

No audio inputs routed over Dante, i.e., no Rx channel assigned to an audio input.  

Single tick  
One or more audio inputs routed over Dante, i.e., an Rx channel is assigned to one or more audio 
inputs. 

Double tick 
 

All configured audio inputs are routed over Dante. i.e., an Rx channel is assigned to all serial 
microphones, miscellaneous inputs and/or Dante feeds. 

Note: 
Dante feed is a third-party Dante source that is processed using an audio input. 

 

Transmitter (DNT06) 

Receiver (VIP03) 
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10. Configure routes as normal: contact inputs, microphone buttons, permanent routes, program/source 
selectors, wall-mount controllers, VOX routes (as source) and/or BGM streams. 

Dante sources will be identified as [DANTE] in the Source list of routing configuration dialogs, and the 
third-party device as DNTxx; see example below for contact input routing.  

Refer to the following sections for further details: 

• “4.7.1 Dante Audio as Source in Contact / Microphone Button / Permanent / Source Selector / 
Wall-Mount Controller / VOX Routes” (page 80) 

• “4.7.2 DANTE Audio as VIPA BGM Sources” (page 82)  

• “4.7.3 Processed Third-Party Dante Source as VOX Route Trigger” (page 83) 

Notes: 
a) The Transport column in routing configuration dialogs identifies the transport methods for voice 

over IP that the receiver can handle (PMC and/or Dante), not necessarily the transport method 
that will used when the route is made. The audio source type will determine the transport method 
that will be used when the route is made. 

b) Unprocessed third-party Dante sources can be routed to VIPEDIA-12-PRO / INTEGRA-PRO units 
only (over Dante). Although routes are allowed in the configuration, unprocessed third-party Dante 
sources will not be routed to standard units. 

c) Although the system configuration is correct, Dante routes will not route audio until the Dante 
Brooklyn II modules are correctly configured using the Dante Controller; see Section “4.5.2 Dante 
Brooklyn II Module Configuration (Third-Party to PRO)” (page 47). 

 

[DANTE] Sources: 
• Sources from third-party devices (DNTxx) are 

unprocessed and will be routed over Dante to 
VIPEDIA-12-PRO and INTEGRA-PRO units. Although 
allowed in the configuration, they will not be routed to 
VIPEDIA-12 / INTEGRA units. 

• Sources from a PAVA Router (VIPxx or ITGxx) will be 
routed over Dante to VIPEDIA-12-PRO and 
INTEGRA-PRO units, and over PMC to standard 
VIPEDIA-12 / INTEGRA units. 

Transport methods for voice over IP that the 
receiver can handle, not necessarily the method 
used when the route is made. 
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11. Load the configuration to the ASL’s 
PAVA devices using the File Transfer 
Tool (FTT). 
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4.5.2 Dante Brooklyn II Module Configuration (Third-Party to PRO) 

Important: 
a) Subscriptions (routes) to third-party devices will not be fully configured when the Dante configuration 

generated by the PAVA SCT is loaded into the Brooklyn II module fitted to VIPEDIA-12-PRO / 
INTEGRA-PRO units. The configuration must be completed using the Dante Controller. 

b) Any subscriptions between VIPEDIA-12-PRO / INTEGRA-PRO units will also be automatically 
configured in the same process. 

 

1. On the PAVA SCT, export the Dante Controller XML configuration using the menu option: 

File > Export Dante Controller File 

 

Alternatively, right-click the Dante item in the device tree and select Export Dante Controller File 
option from the context menu. 
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Or click the Export Dante Controller File button on the Dante page. 
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2. Launch the Dante Controller.  

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller” (page 95) for further details. 

3. Select the Routing tab in Dante Controller - Network View main window, ensure that all required 
devices are present on the network. 

4. Load the Dante XML configuration using the menu option: 

File > Load Preset 
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5. The Preset Elements list shows the elements that can be imported from the configuration.  

It is recommended to select all available elements. 

a. If the MAC addresses are present in the configuration, it should automatically identify and apply 
the role to the correct device.  

 

b. If the MAC addresses are not present in the configuration, assign the roles to the Dante devices 
on the network.  

i. The Preset Roles list shows the devices in the configuration and the Target Devices list 
shows the devices found on the network. 

ii. Select a device in the Preset Roles list and its equivalent device the Target Devices list, 
and then click the Apply Role button. 

Alternatively, select a device in the Preset Roles list, and drag and drop it on top of its 
equivalent device in the Target Devices list. 

iii. Repeat the above steps for all devices in the Preset Roles list.  

Important: 
To simplify identifying the correct device on the network amongst various devices with default 
name, it is recommended that each Dante module is configured whilst it is the only device with 
default name on the network. 
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6. Click the Ok button to apply the configuration.  

It may take a while depending on the number of devices. 

7. Once completed, click the Ok button. 

Device and channel names will have been updated and routes between Dante Brooklyn II modules 
fitted VIPEDIA-12-PRO / INTEGRA-PRO units will be made (if any). 

 

8. On the Routing tab, ensure that all required devices are present on the network. 

Important: 
a) Subscriptions (routes) to third-party devices will be partly configured (unresolved), and the 

Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO units will show a warning icon 
(  ). The subscriptions must be completed (resolved) using the Dante Controller as described in 
the next steps. 

b) You will need to complete the subscription to third-party devices every time the Dante 
configuration generated by the PAVA SCT is loaded into the devices. 
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9. Expand the transmitter device (third-party) along the top.  
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10. For each Dante Brooklyn II module fitted to VIPEDIA-12-PRO / INTEGRA-PRO units, connect the 
required receive channel to the correct transmit channel on the third-party device as described below. 

Important: 
You will need to repeat these steps every time the Dante configuration generated by the PAVA SCT is 
loaded into the devices. 

a. Expand the required receiver device (VIPEDIA-12-PRO / INTEGRA-PRO) along the left side.  
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b. Position the mouse on the intersection of the correct receive (Rx) and transmit (Tx) channels.  

Use the receive channel name as guide to the required transmit channel. 

The receive channel name when configured to a third-party device is of the format: 

 
In the example below, 06-DNT06-SRC01-Input-01 indicates that Rx06 on Integra ITG05 is to be 
connected to Tx01 of the third-party device DNT06. 

 

xx-DNTyy-SRCzz-<Name in the PAVA SCT> 

zz: external device transmit channel number (use this as guide) 

yy: Unit ID of the third-party device in the PAVA SCT 

xx: receive channel number 

Name: can be used as guide when the name in the PAVA SCT is 
same as transmit channel name on the Dante Controller. 
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c. Click on the intersection to create a subscription between the transmit and receive channels 

d. A green tick will appear in the intersection. You may initially see a grey hourglass icon (usually 
very briefly) to indicate that the subscription is in progress. 

In the example below, Integra ITG05:Rx06 is connected to third-party device Mixer-01:Tx01. 
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e. Repeat the above steps for all subscriptions for this third-party device (if any). 

Notes: 
a) The Rx channels of all Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO 

units in the system configuration should subscribe to the same Tx channels across the system. 
This ensures that audio is always routed over IP using the correct transport method.  

b) The Dante channel subscriptions on Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / 
INTEGRA-PRO should match the configuration shown on the Dante page of the PAVA SCT; see 
example in Figure 4 (page 44). 

 

11. Repeat steps 9 and 10 for all subscriptions to other third-party devices (if any). 
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4.6 Third-Party Dante Device to VIPEDIA-12-PRO / INTEGRA-PRO 
VIPEDIA-12 / INTEGRA (Processed) 

This section describes the configuration of processed third-party Dante sources that can be routed to 
VIPEDIA-12-PRO / INTEGRA-PRO units and standard VIPEDIA-12 / INTEGRA units. 

Important: 
a) An audio input is used for each Dante source. 

b) Input dynamic processing (EQ, gate, compressor and limiter) and gain adjustment can be applied to the 
processed Dante input using the Router Dynamic Configuration Tool (RDT). 

c) Can be routed using PMC to remote outputs. 

d) Can also be routed using Dante to outputs on VIPEDIA-12-PRO / INTEGRA-PRO units. 

e) Can be used as VOX gate route trigger like miscellaneous inputs.  

 

 

4.6.1 PAVA SCT Configuration (Third-Party to PRO - Processed) 

1. On the PAVA SCT device tree, right-click the Dante item. 

2. Select Add > Ins, and then External Dante Device. 

The PAVA SCT automatically assigns the lowest available Unit ID (1 to 63 range). 

 

Third-Party Device
(e.g Mixer)

VIPEDIA-12-PRO / 
INTEGRA-PRO

VIPEDIA-12 / 
INTEGRA
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3. Select the required Dante Device in the device tree to load the configuration page. 

4. Enter the device’s Name.  

5. Enter the Dante Module MAC Address; see Section “4.1.3 MAC Address on the Dante Controller” 
(page 14) 

The Dante MAC address of a third-party device is not essential. It is not currently used but may be 
useful in the future. 

6. Select the number of Dante transmit channels from the Number of Dante Feeds drop-down menu (8, 
16, 32 or 64).  
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7. Enter a name for each Dante stream (SRCxx) available from the device, where SRCxx equates to 
Transmit Channel xx on the third-party device. 

Notes: 
a) Using names that are assigned to the transmit channel on the Dante Controller helps the 

configuration.  

b) The source name must be filled in for Rx channel and route configuration. 
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8. Select the Dante streams that will be routed to VIPEDIA-12-PRO / INTEGRA-PRO units by ticking the 
Rx check box of the required stream (SRCxx). 

The PAVA SCT automatically allocates a Dante receive channel (Rx) to the third-party Dante stream 
(SRCxx). 

This tells all VIPEDIA-12-PRO and INTEGRA-PRO units in the system to listen to the this Dante 
stream when this source is routed. 

Important: 
a) Only select an Rx channel for Dante streams that are routed within the PAVA system.  

b) Selecting an Rx channel for streams that are not routed within the PAVA system will reduce the 
number of Dante channels available for the PAVA system.  

In the example below, 5 x Dante streams are selected on third-party device DNT06: SRC01<>Rx06, 
SRC02<>Rx07, SRC11<>Rx08, SRC12<>Rx09, and SRC18<>Rx10. 
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9. The Dante page shows the Dante channel allocation for each PRO and third-party Dante unit in the 
system. 

The Dante page for the transmitter unit (the third-party device) will show a tick in the intersection of 
the transmit channel (Tx) and the configured receive channel (Rx). For receiver units (VIPEDIA-12-
PRO and INTEGRA-PRO units), it will show receive channels (Rx) assigned to the third-party Dante 
streams.  

In the example below, the Dante page for Vipedia VIP03 (and all other VIPEDIA-12-PRO and 
INTEGRA-PRO units) shows receive channel Rx06 assigned to SCR01; Rx07 to SCR02, Rx08 to 
SRC11, Rx09 to SCR12, and Rx10 to SCR18 of third-party device DNT06.  

Figure 5 Dante page example (third-party Dante sources) 

 

 

Tab Label - Icon Description 

Arrow  No audio input configured as serial microphone, miscellaneous input, or Dante feed. 

Star 
 

No audio inputs routed over Dante, i.e., no Rx channel assigned to an audio input.  

Single tick  
One or more audio inputs routed over Dante, i.e., an Rx channel is assigned to one or more audio 
inputs. 

Double tick 
 

All configured audio inputs are routed over Dante. i.e., an Rx channel is assigned to all serial 
microphones, miscellaneous inputs and/or Dante feeds. 

Note: 
Dante feed is a third-party Dante source that is processed using an audio input. 

 

Transmitter (DNT06) 

Receiver (VIP03) 
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10. Configure the audio input that will be used to process the third-party Dante source. 

11. Right-click the required Audio Input. 

12. Select Dante Feed, the third-party Dante device, and then the Dante source.  

In this example, Audio Input 9 is configured as processed Dante input, where DNT06:SRC01 is 
selected as the Dante Feed. 
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13. The processed Dante input will automatically be set to route over Dante if a receive channel (Rx) is 
available in the system. 

Important: 
If the processed Dante source is only for local outputs, then untick Route over Dante for ASL PRO 
devices option to free up a Dante receive channel (Rx).  
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14. Configure routes as normal: contact inputs, microphone buttons, permanent routes, program/source 
selectors, wall-mount controllers, VOX routes (as source), VOX route trigger, and/or as BGM streams. 

Processed Dante inputs will be identified as [Processed] in the Source list of routing configuration 
dialogs; see example below for contact input routing. If the processed Dante input is routed over 
Dante, it will also be identified as [DANTE]; see example below for contact input routing  

Refer to the following sections for further details: 

• “4.7.1 Dante Audio as Source in Contact / Microphone Button / Permanent / Source Selector / 
Wall-Mount Controller / VOX Routes” (page 80) 

• “4.7.2 DANTE Audio as VIPA BGM Sources” (page 82)  

• “4.7.3 Processed Third-Party Dante Source as VOX Route Trigger” (page 83) 

Notes: 
a) The Transport column in routing configuration dialogs identifies the transport methods for voice 

over IP that the receiver can handle (PMC and/or Dante), not necessarily the transport method 
that will used when the route is made. The audio source type will determine the transport method 
that will be used when the route is made. 

b) Unprocessed third-party Dante sources can be routed to VIPEDIA-12-PRO / INTEGRA-PRO units 
only (over Dante). Although routes are allowed in the configuration, unprocessed third-party Dante 
sources will not be routed to standard units. 

c) Although the system configuration is correct, Dante routes will not route audio until the Dante 
Brooklyn II modules are correctly configured using the Dante Controller; see Section “4.6.2 Dante 
Brooklyn II Module Configuration (Third-Party Processed to PRO) (page 67). 

 

[Processed] [DANTE] Sources: 
These processed inputs will be routed over Dante to 
VIPEDIA-12-PRO and INTEGRA-PRO units, and 
over PMC to standard VIPEDIA-12 / INTEGRA units. 

Transport methods for voice over IP 
that the receiver can handle, not 
necessarily the method used when the 
route is made. 

[Processed] Sources: 
These processed inputs will be routed over 
PMC to VIPEDIA-12-PRO and INTEGRA-
PRO units and standard VIPEDIA-12 / 
INTEGRA units. 
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15. Load the configuration to the ASL’s 
PAVA devices using the File Transfer 
Tool (FTT). 
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4.6.2 Dante Brooklyn II Module Configuration (Third-Party Processed to PRO) 

Important: 
a) Subscriptions (routes) to third-party devices will not be fully configured when the Dante configuration 

generated by the PAVA SCT is loaded into the Brooklyn II module fitted to VIPEDIA-12-PRO / 
INTEGRA-PRO units. The configuration must be completed using the Dante Controller. 

b) Any subscriptions between VIPEDIA-12-PRO / INTEGRA-PRO units will also be automatically 
configured in the same process. 

 

1. On the PAVA SCT, export the Dante Controller XML configuration using the menu option: 

File > Export Dante Controller File 

 

Alternatively, right-click the Dante item in the device tree and select Export Dante Controller File 
option from the context menu. 
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Or click the Export Dante Controller File button on the Dante page. 
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2. Launch the Dante Controller.  

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller” (page 95) for further details. 

3. Select the Routing tab in Dante Controller - Network View main window, ensure that all required 
devices are present on the network. 

4. Load the Dante XML configuration using the menu option: 

File > Load Preset 
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5. The Preset Elements list shows the elements that can be imported from the configuration.  

It is recommended to select all available elements. 

a. If the MAC addresses are present in the configuration, it should automatically identify and apply 
the role to the correct device.  

 

b. If the MAC addresses are not present in the configuration, assign the roles to the Dante devices 
on the network.  

i. The Preset Roles list shows the devices in the configuration and the Target Devices list 
shows the devices found on the network. 

ii. Select a device in the Preset Roles list and its equivalent device the Target Devices list, 
and then click the Apply Role button. 

Alternatively, select a device in the Preset Roles list, and drag and drop it on top of its 
equivalent device in the Target Devices list. 

iii. Repeat the above steps for all devices in the Preset Roles list.  

Important: 
To simplify identifying the correct device on the network amongst various devices with default 
name, it is recommended that each Dante module is configured whilst it is the only device with 
default name on the network. 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 71 of 100 

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 72 of 100 

6. Click the Ok button to apply the configuration.  

It may take a while depending on the number of devices. 

7. Once completed, click the Ok button. 

Device and channel names will have been updated and routes between Dante Brooklyn II modules 
fitted VIPEDIA-12-PRO / INTEGRA-PRO units will be made (if any). 

 

8. On the Routing tab, ensure that all required devices are present on the network. 

Important: 
a) Subscriptions (routes) to third-party devices will be partly configured (unresolved), and the 

Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO units will show a warning icon 
(  ). The subscriptions must be completed (resolved) using the Dante Controller as described in 
the next steps. 

b) You will need to complete the subscription to third-party devices every time the Dante 
configuration generated by the PAVA SCT is loaded into the devices. 
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9. Expand the transmitter device (third-party) along the top.  
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10. For each Dante Brooklyn II module fitted to VIPEDIA-12-PRO / INTEGRA-PRO units, connect the 
required receive channel to the correct transmit channel on the third-party device as described below. 

Important: 
You will need to repeat these steps every time the Dante configuration generated by the PAVA SCT is 
loaded into the devices. 

a. Expand the required receiver device (VIPEDIA-12-PRO / INTEGRA-PRO) along the left side.  

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 75 of 100 

b. Position the mouse on the intersection of the correct receive (Rx) and transmit (Tx) channels.  

Use the receive channel name as guide to the required transmit channel. 

The receive channel name when configured to a third-party device is of the format: 

 
In the example below, 06-DNT06-SRC01-Input-01 indicates that Rx06 on Integra ITG05 is to be 
connected to Tx01 of the third-party device DNT06. 

 

xx-DNTyy-SRCzz-<Name in the PAVA SCT> 

zz: external device transmit channel number (use this as guide) 

yy: Unit ID of the third-party device in the PAVA SCT 

xx: receive channel number 

Name: can be used as guide when the name in the PAVA SCT is 
same as transmit channel name on the Dante Controller. 
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c. Click on the intersection to create a subscription between the transmit and receive channels 

d. A green tick will appear in the intersection. You may initially see a grey hourglass icon (usually 
very briefly) to indicate that the subscription is in progress. 

In the example below, Integra ITG05:Rx06 is connected to third-party device Mixer-01:Tx01. 
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e. Repeat the above steps for all subscriptions for this third-party device (if any). 

Notes: 
a) The Rx channels of all Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / INTEGRA-PRO 

units in the system configuration should subscribe to the same Tx channels across the system. 
This ensures that audio is always routed over IP using the correct transport method.  

b) The Dante channel subscriptions on Dante Brooklyn II modules fitted to VIPEDIA-12-PRO / 
INTEGRA-PRO should match the configuration shown on the Dante page of the PAVA SCT; see 
example in Figure 4 (page 44). 

 

11. Repeat steps 9 and 10 for all subscriptions to other third-party devices (if any). 
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4.6.3 Processing Audio from Third-Party Dante Device 

1. Launch the RDT from the PAVA SCT; refer to the VIPEDIA-12 User’s Manual(Table 2:[2] on page 94). 

2. Select the required VIPEDIA-12-PRO/INTEGRA-PRO from the drop-down menu located on the 
bottom-left corner of the main GUI. 

The RDT shows the input type at the top of each control bar: ANALOGUE for miscellaneous and 
microphone inputs, and DANTE for processed Dante inputs. The Sensitivity and Phantom Power 
are hidden in the Properties dialog for processed Dante inputs.  

 

Type = DANTE 

No Sensitivity and Phantom Power controls 

Note: 

The input number for 
processed inputs is not 
the audio input number 
used to process the third-
party Dante source; see 
details in the next 
diagrams. 
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RDT - Input numbering for processed Dante inputs: 

 

 

Processed Dante input using Audio Input 9 

INPUT is the Rx channel used to 
listen to the third-party Dante source. 

In this example, INPUT 6 = Rx:06 
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4.7 Configuration of Dante Audio in PAVA Routes 
Dante audio sources (unprocessed and processed) can be routed by all standard routing mechanisms: 

• “4.7.1 Dante Audio as Source in Contact / Microphone Button / Permanent / Source Selector / Wall-
Mount Controller / VOX Routes” (page 80) 

Dante audio sources can also be configured as VIPA BGM sources: 

• “4.7.2 DANTE Audio as VIPA BGM Sources” (page 82) 

Processed external Dante inputs can be configured as VOX route triggers: 

• “4.7.3 Processed Third-Party Dante Source as VOX Route Trigger” (page 83) 

4.7.1 Dante Audio as Source in Contact / Microphone Button / Permanent / 
Source Selector / Wall-Mount Controller / VOX Routes 

1. On the PAVA SCT device tree, select the required contact input, microphone button, permanent route 
entry, program/source selector, wall-mount controller or VOX route trigger input.  

Please refer to the PAVA SCT User’s Manual (Table 2:[1] on page 94) for details on how to configure 
the required route trigger.  

2. Select the required Dante source from the Source drop-down list; see examples below.  

Notes: 
a) The Transport column in routing configuration dialogs identifies the transport methods for voice 

over IP that the receiver can handle (PMC and/or Dante), not necessarily the transport method 
that will used when the route is made. The audio source type will determine the transport method 
that will be used when the route is made. 

b) Although routes are allowed in the configuration, unprocessed third-party Dante sources will not 
be routed over PMC to standard VIPEDIA-12 / INTEGRA units. Unprocessed third-party Dante 
sources can be routed to VIPEDIA-12-PRO / INTEGRA-PRO units only (over Dante). 

VIPEDIA-12-PRO / INTEGRA-PRO [DANTE] sources: 

 

[DANTE] Sources: 
Sources from a PAVA Router (VIPxx or ITGxx) will be 
routed over Dante to VIPEDIA-12-PRO and INTEGRA-PRO 
units, and over PMC to standard VIPEDIA-12 / INTEGRA 
units. 
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Unprocessed third-party [DANTE] sources: 

 

[Processed] third-party Dante sources: 

 

3. Configure the other routing options associated with the selected route trigger. 

 

[DANTE] Sources: 
Unprocessed sources from third-party devices (DNTxx) will 
be routed over Dante to VIPEDIA-12-PRO and INTEGRA-
PRO units. Although allowed in the configuration, they will 
not be routed to VIPEDIA-12 / INTEGRA units. 

Transport methods for voice over IP that the 
receiver can handle, not necessarily the method 
used when the route is made. 

[Processed] [DANTE] Sources: 
These processed inputs will be routed over Dante to 
VIPEDIA-12-PRO and INTEGRA-PRO units, and 
over PMC to standard VIPEDIA-12 / INTEGRA units. 

Transport methods for voice over IP 
that the receiver can handle, not 
necessarily the method used when the 
route is made. 

[Processed] Sources: 
These processed inputs will be routed over 
PMC to VIPEDIA-12-PRO and INTEGRA-
PRO units and standard VIPEDIA-12 / 
INTEGRA units. 
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4.7.2 DANTE Audio as VIPA BGM Sources 

VIPEDIA-12-PRO / INTEGRA-PRO and third-party Dante sources can be configured as BGM source routed 
by the Network Cards in the PAVA system; see routing details in Figure 6 (page 82). 

 

1. On the PAVA SCT, open the BGM Streams page. 

2. Click the Add BGM Stream button. 

3. Select the required Dante source. 

Figure 6 BGM Stream - Dante sources 

 

 
 

• [DANTE] BGM sources from a PAVA Router (VIPxx or ITGxx) will be 
routed over Dante to VIPEDIA-12-PRO and INTEGRA-PRO units, and 
over PMC to standard VIPEDIA-12 / INTEGRA units. 

• Unprocessed [DANTE] BGM sources from third-party devices (DNTxx) 
will be routed over Dante to VIPEDIA-12-PRO and INTEGRA-PRO units. 
They will not be routed to VIPEDIA-12 / INTEGRA units. 

• [Processed] [DANTE] BGM sources will be routed over Dante to 
VIPEDIA-12-PRO and INTEGRA-PRO units, and over PMC to standard 
VIPEDIA-12 / INTEGRA units. 

• [Processed] BGM sources will be routed over PMC to VIPEDIA-12-PRO 
and INTEGRA-PRO units and standard VIPEDIA-12 / INTEGRA units. 
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4.7.3 Processed Third-Party Dante Source as VOX Route Trigger 

1. On the PAVA SCT device tree, select the required processed Dante input. 

 

2. Enable the VOX Routing option.  

The routing configuration dialog will be displayed. 

3. Select the required source from the Source drop-down list and configure the route as normal. 

The example below shows the processed input as source. 
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4. Load the configuration to the ASL’s 
PAVA devices using the File Transfer 
Tool (FTT). 

 

5. Launch the RDT to enable, and select the required VIPEDIA-12-PRO/INTEGRA-PRO from the drop-
down menu located on the bottom-left corner of the main GUI.  

6. Open the Properties dialog for the required processed Dante input that acts as VOX route trigger. 

7. Enable the Gate in the 
input processing.  

8. Set the Threshold to a 
suitable level to trigger 
the route. 

9. Set Attack to 0.1 ms 
(i.e. as fast as possible). 

10. Set the Hold Time to 
suitably high level.  

The Hold Time defines 
the amount of time 
required below the 
Threshold before the 
route is cleared. 

Usually set between 
5000 ms to 10000 ms to 
allow for breaks between 
songs in BGM, etc. 

11. Set Release to 1000 ms 
(or as required) so that 
the route fades out 
reasonably smoothly. 

 
12. Commit the changes. 
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5 Dante Brooklyn II Module Firmware Update 

 
VIPEDIA-12-PRO / INTEGRA-PRO units out of the box are supplied with Dante firmware version 
that is approved for EN 54-16 applications. 

For EN 54-16 compliance: 
a) Firmware update must be to a version of product firmware that is approved by ASL.  

If in doubt, please contact ASL. 
b) Change to product firmware can only be done at access level 4 which must be 

restricted to persons trained and authorised by ASL to alter the firmware. 

Important: 
a) You will need to install the Dante Firmware Update Manager on the configuration PC. 

The Dante Firmware Update Manager is available on request from Audinate or ASL.  

Note that it is not possible to update the Dante Firmware using the Dante Updater function on the Dante 
Controller. Dante modules on VIPEDIA-12-PRO / INTEGRA-PRO units will be listed under CONSULT 
MANUFACTURER. 

 
b) The required Dante firmware image. 

The Dante firmware image is available on request from Audinate or ASL. 

c) If any difficulties are encountered, contact ASL. 
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1. Launch the Dante Firmware Update Manager. 

2. Select the correct network interface and click the Next button. 

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller” (page 95) for further details. 
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3. Click the Update Dante Firmware button. 
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4. Browse to the required firmware image. 

Important: 
Firmware update must be to a version of product firmware that is approved by ASL. If in doubt, please 
contact ASL. 
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5. Tick the Override Device Matching. 

 

Override Device Matching must be 
selected. Otherwise, the Firmware 
Updater will NOT find VIPEDIA-12-PRO 
/ INTEGRA-PRO units. 
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6. Click the Yes button in this warning 
dialog box. 

 

7. The Update Manager should display all Dante devices on the network. 
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8. Select the target device(s) or all devices (Select All option) and click the Start button. 

 

9. Click the OK button in this warning 
dialog box. 

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 92 of 100 

10. The update will start. 

Wait for the update to complete. 

DO NOT POWER DOWN THE UNIT DURING THE UPDATE. 
11. When the update completes, an Upgrade Done message with the update results should be displayed. 

Click the OK button. 

The Update Manager will show the result of the upgrade operation. 

 
12. Power cycle the unit.  

 

 

 



VIPEDIA-12-PRO / INTEGRA-PRO – Dante Configuration Guide 
 
 

 
U-0641-3466.docx – Issue: 01 complete, approved 

Page 93 of 100 

6 Acronyms 

ADT  Amplifier Dynamic Configuration Tool (ASL) 
AS Active Standby (ASL) 
ASL Application Solutions (Safety and Security) Limited 
BGM BackGround Music 
BMB01 Remote I/O Unit (ASL) 
CP Computer Processor 
DBB Digital BackBone (ASL) 
DVA Digital Voice Announcer 
EQ Equaliser 
GPIO General Purpose Inputs/Outputs 
GUI Graphical User Interface 
ID Identification 
IGMP Internet Group Management Protocol 
INTEGRA Wall-mount Voice Alarm System (ASL) 
INTEGRA-PRO Wall-mount Voice Alarm System (Integrated Dante™) (ASL) 
IP Internet Protocol 
MAC Media Access Control 
NA Not Available/Not Applicable 
NIC Network Interface Card 
PA Public Address 
PA/VA Public Address and Voice Alarm 
PAVA Public Address and Voice Alarm 
PAVA SCT PAVA System Configuration Tool (ASL) 
PC Personal Computer 
PMC Portable Media Carrier (ASL’s audio over IP format) 
PRO VIPEDIA-12-PRO and  INTEGRA-PRO  (ASL) 
QR Quick Response code 
RDT Router Dynamic Configuration Tool (ASL) 
RSTP Rapid Spanning Tree Protocol 
VA Voice Alarm 
VCT VIPA Config Tool (ASL) 
VIPA Voice over IP Audio (ASL) 
VIPEDIA-12 Professional Sound Life-Safety Digital Audio System (ASL) 
VIPEDIA-12-PRO Professional Sound Life-Safety Digital Audio System (Integrated Dante™) (ASL) 
VIPEDIA-NET VIPEDIA-12 Network Card 
XML Extensible Markup Language 
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7 Reference Documentation 

Table 2 Reference documents 

Ref. No Title Filename Ref Origin 

[1]  PAVA SCT User’s Manual (V3.x) U-0701-1583 ASL 

[2]  VIPEDIA-12 User’s Manual (V3.x) U-0641-3283 ASL 

[3]  INTEGRA User’s Manual (V3.x) U-0732-0051 ASL 

[4]  V2000 User’s Manual (V3.x) U-0623-1005 ASL 

[5]  Hirschmann Network Switch Configuration Guide U-0641-3488 ASL 

[6]  NETWORK-SWITCH-LP01 Configuration Guide U-0641-3675 ASL 

All latest revisions of all user documentation are available from ASL’s downloads page. 

 
www.asl-control.co.uk/downloads 

 

http://www.asl-control.co.uk/downloads
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APPENDIX A – PC Requirements for ASL Configuration Tools 
and Dante Controller 

The PC used for firmware and configuration update should meet the following requirements for correct 
operation of ASL configuration tools and Dante Controller.  
 

1. The operating system on the configuration PC should be Windows 10. 

2. The configuration PC must have an Ethernet connection to the target unit. 

Do not connect the configuration PC to a mirror port of network switch. 

Alternatively, the configuration PC can be directly connected to an Ethernet port on target unit.  

3. Configure the settings of the PC’s network interface that is used to connect to the system according to 
the target device (network): 

• ASL devices (e.g. VIPEDIA-12-PRO / INTEGRA-PRO): the network interface must have an static IP 
address in the same subnet as the target device. 

• Dante devices: the network interface must have a dynamic IP address 

A single network interface can be used for both networks, but it must be reconfigured for each network. 

To change the configuration PC’s IP address settings: 

a. Click the Start button in the bottom-left corner of your 
screen.  

b. Enter “ncpa.cpl” in the Search box and double-click the 
ncpa.cpl program.  

c. The Network Connections window will be displayed. 

d. In the Network Connections window, right-click the 
interface that is used to connect to the target unit, and 
then select Properties from the popup menu. 

 

e. The Properties window for the interface card will be 
displayed.  

f. Select the Networking tab and then select Internet 
Protocol Version 4 (TCP/IPv4) in the connections list. 

g. Click the Properties button. 

h. The Internet Protocol Version 4 (TCP/IPv4) 
Properties window will be displayed. 

 

Interface connected 
to the target unit 
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For ASL devices: 
a. Click the Use the following IP Address option and 

enter the configuration PC’s IP address. 
Ensure that the PC’s IP address is in the same subnet 
as the target unit.  

In the example on the right: 

• Target units in a 192.168.1.0/24 network (factory 
default for ASL PA/VA equipment) 

• Configuration PC on a free address in the same 
subnet (e.g. 192.168.1.63) 

b. Enter the required Subnet mask or press the TAB key 
on the keyboard (Windows will set the default subnet 
mask). 

c. Click the OK button to apply the changes. 
 

 

Multiple IP addresses can be assigned to a single network 
interface. This is normally used when the configuration PC 
is required to connect to units in different subnets, for 
example, when new “out of the box” units are configured 
with IP address outside the factory default subnet 
(192.168.1.0/24). 

To assign multiple IP addresses to a network interface: 

a. Re-load the Internet Protocol Version 4 (TCP/IPv4) 
Properties window. 

b. Click the Advanced button. 

 

 

 

c. Click the Add button on the Advanced TCP/IP 
Settings window. 

 

 

 

 

d. Enter the configuration PC’s IP address in the new 
subnet. 

In the example on the right: 

• Target units in a 10.1.1.0/24 network 

• Configuration PC on a free address in the same 
subnet (e.g. 10.1.1.100) 

e. Enter the required Subnet mask or press the TAB key 
on the keyboard (Windows will set the default subnet 
mask). 

f. Click the Add button. 

g. Repeat the procedure for all required subnets.  
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For Dante devices: 
a. Select the Obtain an IP Address automatically. 

b. Click the OK button to apply the changes. 

 

4. If the configuration PC has multiple network interfaces, ensure that the network interface used to 
connect to the target ASL unit has the highest priority by changing the metrics; see below.  

Alternatively, the other network interfaces can be temporarily disabled. 

To change the Interface Metrics: 

a. In the Network Connections window, right-click the 
interface that is used to connect to the target unit, and 
then select Properties from the popup menu. 

 

b. The Properties window for the interface card will be 
displayed. 

c. Select the Networking tab and then select Internet 
Protocol Version 4 (TCP/IPv4) in the connections list. 

d. Click the Properties button. 

 

Interface connected 
to the target unit 
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e. The Internet Protocol Version 4 (TCP/IPv4) 
Properties window will be displayed. 

f. Click the Advanced button. 

 

g. The Advanced TCP/IP Settings window will be 
displayed; see example on the right. 

h. Select the IP Settings tab. 

i. If checked, uncheck the Automatic metric check box. 

j. Set the Interface metric to “1”. 

k. Click the OK button to apply the changes. 

l. Repeat the above procedure for all other network 
interfaces ensuring that they are set to a lower priority 
(value > 1), and not set to automatic. 

 

5. Ensure that the target unit is up running and connected to 
the network, for example, using the “ping” command in a 
Command Prompt. 

a. Click the Start button in the bottom-left corner of your 
screen. 

b. Enter “cmd” in the Search box and double-click the 
cmd.exe program. 

c. In the Command Prompt, enter the “ping” command 
followed by the IP address of the target unit.  

For example: 
ping 192.168.1.10 

 

 
 

Interface connected 
to the target unit 

Target unit with IP address 192.168.1.10 is 
up running and connected to the network 

Target unit with IP address 192.168.1.20 
is not connected to the network 
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APPENDIX B – Getting the firmware version on a Dante 
Brooklyn II module 

Important: 
Ensure that the configuration PC’s network interface used to connect to the Dante devices is correctly 
configured to dynamic IP address; see “APPENDIX A – PC Requirements for ASL Configuration Tools and 
Dante Controller” for further details.  

 

1. Launch the Dante Controller. 

2. Select the Routing tab in Dante Controller - Network View main window. 

3. Double-click the required device name in matrix to open the Device View window. 

4. Select the Status tab. 

The firmware versions are shown in the Dante Information box. 
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APPENDIX C – Serial Number Label 

VIPEDIA-12 / VIPEDIA-12-PRO Serial Number and Build Standard 

The serial number label of rack-mount units, such as the VIPEDIA-12 / VIPEDIA-12-PRO, is located on the 
rear or side of the unit; see example in Figure 7 (page 100).  

Figure 7 VIPEDIA-12 serial number label example 

 

INTEGRA / INTEGRA-PRO Serial Number and Build Standard 

The serial number of an INTEGRA / INTEGRA-PRO unit is located on side of the unit; see example in Figure 
8 (page 100). 

Figure 8 INTEGRA’s serial number label example 

 
 

 

The last section of the barcode after the second forward slash (/) 
indicates the unit’s Build Standard (BS) version. 
Example: 1320/750640/02B  BS Version = 02 

Serial Number Label 
Build Standard (BS) Version 

The last part of the serial number indicates the unit’s 
Build Standard (BS) version. 
Example: 1635-000010-03  BS Version = 03 

(Actual label may differ from image shown.) 
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